
CS 1704 Fall 96
Project Specifications
Documentation On-line Catalog

Documentation On-line Catalog (DOC) is an interactive code
library documentation access tool. DOC will provide facilit ies
for viewing, selection, traversing, and indexing documentation
information. The reference set, category and documentation  file
formats that DOC will operate upon are the same as given in the specifications for the Reference
Set Manager and Validation Checker programs.

The discussion that follows describes the DOC interface and operations in detail. Very minor
deviations from these specifications may not result in grade penalties. However, programmers
would be well advised to receive prior approval before altering any of these requirements.

    Discussion   
DOC will begin execution with a startup screen giving the usual information about the system
and developer, along with the current product version number. The startup, splash, screen
should be presented in a manner to capture a viewer's attention. After the user hits the re turn
key, the startup screen will clear and the DOC screen will be displayed, (see DOC screen layout,
Figure 1). The command line parameters are then accessed to open the optional  doclib. RFS f i le.
The doclib.RFS file name, if present, follows the DOC program name on the operating system
command line: “doc doclib”. A file existence check for any file opened is required and an e r r o r
message is displayed if the file is not present. The user may alternatively elect to start DOC
without any command line parameters. In this case the user must first open an existing
doclib.RFS or root category file before any other DOC menu commands become available. The
remaining discussion will be made with regards to the areas of the DOC screen layouts and how
the system execution affects them.

The DOC screen will be divided up into several areas: the menu area, display area, I/O area and
the status area. The contents of these areas may change, but the four areas will be  maintained on
the screen at all times, after the startup screen has cleared and until the DOC quit operation
executes. The menu area will hold the names of the pull-down menus available to the user,
containing all DOC system commands. The display area will be used to show various
documentation information, dependent upon the user’s request. The I/O area is employed by DOC
to give error/warning or prompt messages and to accept keyboard input. (All input from the I/O
line, unless explicitly noted, will be buffered, (i.e. cin<< & cin.getline). All other input, [menu
selection and scrolling actions], will be unbuffered.  The status line will contain 3 fields: 1. the
label of the current open DOC RFS set file,  left justified; 2. the DOC system name, centered and
inversely displayed ; and 3. the DOC RFS root or current category file label, (dependent upon
the display area contents), almost right justified. Note: most terminals, (and terminal
emulators), will automatically scroll one line whenever a character is displayed at the lower
right corner, (row 25 column 80), so care must be taken to ensure that this auto-scrolling
does not affect the DOC system display.

    Menu       Commands   
It is now time to explain how the pull down menus are to be accessed and how they will behave i n
DOC. Following this menu operation explanation, the rest of this section will discuss each pu l l
down menu and the commands that they contain. A user will activate a desired menu by hitt ing
the first letter of the menu, [ P , F , E , V , S ]. This will cause the corresponding menu and
it’s commands to be displayed, with a inversely displayed selection bar  highlighting the
first command, (inverse foreground & background colors),. The user may move (scroll), the
selection bar up/down the menu using the ↑ ↓  cursor keys, with the bar wrapping around f rom
top to bottom and vice-versa. The user may choose a command by hitting the return/enter key



CS1704 Fall 1996 Project Specifications

Documentation Online Catalog DOC.2

when the bar is positioned over the desired command, which will of course cause the command to
be performed. The user may also elect to NOT choose a command and exit the menu without
selecting a command by hitting the delete/backspace key. After a user has chosen, or decided not
to choose, a menu command  the menu should be erased from the screen and the display area
restored. Dashed lines in a menu indicate a division of semi-related commands. When scrolling
they should be automatically skipped over and never highlighted. Horizontal scrolling between
the menus is not required. If the user attempts to perform am illegal menu command then this
must cause a bell to sound or the screen to flash and an appropriate error message to be
displayed on the I/O line. At any time during the execution of a menu command that might
require prolonged processing, the user should be instructed to wait, with an appropriate
message. RFS, Category or Documentation files that must be processed due to the execution of a
menu command, must result in validation of the file’s contents. Any file that contains an invalid
format should not be input. The DOC screen must be restored to the contents prior to command
execution for invalid files, and DOC returned to it’s corresponding state of execution, with an
appropriate error message.

Figure 1.
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Function Name: newwin

Description: Creates a new curses window with dimensions
specified by the parameters.

Syntax: newwin ( lines , cols , begin_y , begin_x )

Includes: curses.h

Parameters: lines-win height, cols-win width, begin_y-start row,
begin_x-start col

Returns: NULL if window cannot be created

Example: newwin ( 20, 60, 2, 10 ) ;
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Prog
The Program menu will contain only two commands, About and Help. The
About command will display the initial startup screen and will be removed
after the user hits the return key, restoring the display area contents. The

Prog
  About
  Help

Help screen will present a brief one screen overview of the DOC system and will also be
removed after the user hits the return key, restoring the display area contents.

F i le
New will prompt the user for the name of the root category file. DOC then
reads the root category file and builds the reference set list of all of the category and
documentation files derived from the category files, ordered upon the file names. It
then shows the brief category description of the root category on the first line of the
display area, skips a line and shows the full category description. The Open
command prompts the user for the name of an existing RFS (reference set),
file to open. At this point the RFS file is read and the list data structure i s
created. DOC will then display the root category file information in the same

File
  New  .  .  .
  Open  .  .  .
  Save
  save As  .  .  .
  Close
  Quit

manner as New command. (Note — the root category file should have the same prefix name as the
RFS file. For RFS files that have no correspondingly named root category file, DOC will display
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the first category file listed in the RFS.) Both the New and Open commands will prompt the user
first to see if they wish to close the current open RFS file, if one is open. (If the user decides not
to close the current RFS file then the file menu is exited with no action taking place). If the user
does wish to close the current RFS file then the close command is automatically executed at this
point and the New or Open command operation continues. The Save command simply writes the
current contents of the internal RFS list structure onto the disk in the RFS file format in the
current directory. Over-writing any other version of the file that might exist in the directory.
The save As command operates almost the same as the save command, except that the user i s
prompted for the name for a new RFS file, which is then created and written to the disk,
becoming the current open RFS test file, (causing a status line update). The Close command w i l l
simply clear the display area and destroy the RFS list structure, (ideally it would be nice to
inform the user if they have not saved the RFS file if changes have been made and give the option
for doing so, but this is not required). The Quit command will prompt the user to confirm that
they wish to exit DOC, destroy the RFS list structure and close any open files, before clearing
the screen and returning to the operating system.

Edit
The Edit menu will provide a simple mechanism for a user to modify the
reference set information. The first 2 options, (Undo and Redo),  are f o r
future commands and are not operable in version 1.0 of DOC. The user
should either be give a message to his effect if they are selected or not be
allowed to select them. However, they must be displayed on the menu. The
next two commands are only for operating upon the RFS list file data. The
Add command will prompt the user for the name of a file to insert into the
current open RFS set. (The user is required to create the file beforehand
using an editor external to DOC.) The created file is inserted into the RFS
list, opened, processed and shown in the display area. The file’s type is

Edit
  Undo
  Redo
 — — — — — —
  Add  .  .  .
  Delete  .  .  .
 — — — — — —
  Name  .  .  .
  Label  .  .  .
  Type  .  .  .  

determined from the extension and the default label is the same as the name of the file. The
Delete command will remove the current displayed category or documentation file from the RFS
list, after the user confirms the deletion. In the case of deletion of a category file, all of i t ’ s
included category and documentation files are also removed, unless they are included f rom
another category file. A simple method to implement this is to maintain a reference count in the
RFS list data of the number of times a file has been included from category files. Reducing this
count by one in the case of a deletion and removing it when the reference count is zero. Deletion
of the root category file will not necessarily remove all elements from the RFS set list, since
some files may be referenced by multiple category files. However, it may result in all of the
category files being deleted, giving rise to ‘orphaned’ documentation files. It is the user’s
responsibility, (not DOC’s), to handle this case. After a deletion has been successfully
performed, the display must be updated to show the root category file information, (or the f i r s t
category file in the RFS list in the event of no root category file.)

The last 3 commands are performed upon the currently displayed category or documentation f i le
data. The user is prompted for the altered value in the I/O area. The prompt must include the
current value of the Name, Label or Type. The file data is then updated in the display area and i n
the RFS, (causing a reordering of the RFS list in the case of a name change). If the user enters a
null string, (simply hits the return key), then the existing stored data should remain
unchanged. Note — DOC is not responsible for changing the category or documentation actual f i le
contents. The user is responsible for this change, external to DOC. DOC is only responsible f o r
altering the RFS file contents.
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View
The View menu will contain five commands. The Description command w i l l
display the full description for the documentation file, in the display area.
The Code info command will likewise display the documentation f i le ’s  non-
full description data in the display. Thus the Description and Code info
commands are inverse, toggle commands. The Root command will cause the
root category file to become the current displayed file. The Back command
will cause the last displayed file to become the current displayed file. The

View
  Description

  Code info
  — — — — — —
  Root
  Back
  Index  .  .  .  

Index command will show the RFS list item labels in the display area, (or a popup window), 2 0
at a time. The first label should be highlighted with a inversely displayed selection b a r
that the user can position over to highlight the desired label that they wish to become the
current category or documentation data. They may change the “current label line” by moving
the display area inverse video selection bar, vertically using the ↑ ↓  cursor keys, one l ine
vertically up/down at a time. When the selection bar is located at the top or bottom of the
display area and the user depresses the ↑ ↓  cursor key respectively, the display area contents
will scroll one label. The label scrolled into the display area becomes the current highlighted
label. If the inverse selection bar is positioned at the top or bottom of the RFS list, (i.e. at the
head or the tail),  and the user attempts to scroll beyond the list bounds, this should cause a bel l
to sound or the screen to flash and an appropriate error message to be displayed on the I/O line.
In addition to the single line scrolling just described, DOC will provide two other index l i s t
‘browsing’ methods. The user may also scroll up/down a 'page', [a page in this context is defined
to be the number of RFS list labels shown in the display area, approx. 20], at a time by
pressing 'U' or 'u' / 'D' or 'd' respectively, (alternatively one may choose to use the PgUp and
PgDn keys). DOC will also allow the top or bottom of the data list to be moved to directly, by the
user depressing either the ‘T’ or ‘t’ / ‘B’ or ‘b’ keys, respectively, (one may also choose to use
the Home and End keys). The display area should never contain blank lines for RFS lists wi th
   >   20 elements. Consider a list with 100 elements, if currently elements 11 through 30 are
displayed and page up is hit, the first 20 elements in the list should now be on the screen.
Similarly, if elements 71 through 90 are displayed and page down is hit, the last 20 elements
(81..100) are then displayed. For files with <20 elements, page up/down would receive an
error message and line up/down should not cause any line/element to scroll off the display.
Display speed is not an over-riding factor for implementation of these index browsing actions.

See also
The See also menu is a dynamic menu whose contents will change as the
current displayed file category or documentation changes. When a category
file is the current displayed file, then the See also menu will contain the
labels of the files listed in the category file. When a documentation file i s
being displayed  the menu will contain the see also file labels from line 1 1
of the documentation file. The see also labels should match exactly other file

See also
  Window FNs 
  Cursor FNs
  Input FNs
  Init FNs
  Misc FNs 

labels in the RFS list. When a user selects a see also label, DOC will search for the
corresponding label in the RFS list. The category or documentation information for the see also
will then be shown making it the current displayed file. If the corresponding label in the RFS
list cannot be found an appropriate error message must be issued.

   Text        Windowing
The use of a text windowing package is NOT required for this program, but is strongly advised.
The ability to define multiple windows to refer to the same screen area will greatly aid the task
of screen content management. The restoring of the display area’s contents after displaying
pull-down menus and switching between different display area contents will be made simple.
The text windowing facilities will greatly enhance the professional look-and-feel of the project.

For students coding a non-text windowing interface, the interface specifications described above
must still be adhered, with the following modifications. The display area will be lines 1-22, the
menu bar on line 23, the status area on line 24 and the I/O area on line 25. When a user selects
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a menu, the complete screen should be redrawn with the menu area line, (23), replaced by the
menu commands. The user will be allowed to select a menu command by hitting the first letter of
the command. In the case of the  See also menu, the complete screen should be redrawn with the
display area replaced by the menu commands, (labels) which must be numbered. This allows a
user to enter the number of the label of the desired category or documentation file. The index
command of the View menu should be handled analogously. The screen must be redrawn after a
menu selection occurs. A non-text windowing interface will require the creation of a window
ADT and menu ADT for controlling the screen contents.

A specification addendum for this project may be forthcoming shortly if required. The addendum
will describe minor enhancements or changes to DOC.

    PROJECT  GRADING  and  DOCUMENTATION
Successful completion of this software development and implementation project will result in the
following External and Internal Specification Documents for submission:

1. A complete STRUCTURE CHART of the system's design, including all interface specifications.
The structure chart must be of sufficient detail to communicate to others WHAT functions are
needed to implement this system and how the various parts are interconnected. The structure
chart is complete if the algorithms for each module could be developed from it, along with a Data
Dictionary, although no data dictionary is required. Use only 8 1 /2 " X 11" sheets of paper to
record the chart, DO NOT use larger sized pages. Pages must be bound or stapled together. Use the
symbols described in class for the components and the interfaces. Legibility counts and points w i l l
be deducted for sloppily presented work. Careful and CORRECT notation is also required and points
will be deducted for a poorly annotated chart. The final chart will be compared with the in i t ia l
chart to determine the amount of modification made to the original system design. Penalties w i l l
be incurred according to the amount of modification. Note - calls to standard C/C++ system
routines: cin, cout, etc. need not be annotated on the chart.

2. An INTEGRATION PLAN , that is a plan for HOW and WHEN the various phases of the project
will be developed and which modules will be added at each integration point.

    a. THREE integration points must be given. The points reflect a semi-equal division of the
project work. (Specifying only 2 modules to be completed at the first 2 points, while delegating
the remaining, approximately 90% of the project for the last point would be unacceptable.

b. For each integration point, you  must name the  TASKS that will be completed by the
identified date and clearly define WHAT BEHAVIOR can be expected to be exhibited by your
program at that point.

c. The three integration points for the system are: 1. 10/2/96 2. 11/6/96 3. 12/9/96.
Each student will be expected to demonstrate to their GTA the behavior of their project second and
last integration points. Failure to meet with the GTA for the demo will result in point penalties.

d. At any integration point or when the program is submitted, any non functioning
commands, actions, etc. of the system are not expected to bomb the system. A message should be
displayed informing the user that this operation has not currently been implemented or is s t i l l
under development. On the final submission, all non functioning aspects of the system MUST be
accompanied by a short explanation describing the suspected problem(s).

3. A USER MANUAL  generated by the word processor of your choice must be written. The manual
should enable the NOVICE DOC user to access all the features of the  system. This document should
be at least 6-8 pages in length, excluding the title page, table of contents, index, etc.

    QUALITY OF CODE
It is expected that the code will be WELL-DOCUMENTED, appropriately indented and VERY
READABLE. Points will be deducted for poorly presented code. Individual functions, excluding
their documentation and declarations may be no longer than one page. Each compilation module
should contain only related procedures. Function headers should resemble the following template:
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(******************************************************)
(*FUNCTION NAME                                       *)
(*DESCRIPTION OF FUNCTION (4-5 LINES)                 *)
(*DESCRIPTION OF ALGORITHM : FUNCTION IMPLEMENTATION  *)
(*                             *)
(*CALLED BY: (LIST OF FUNCTIONS)                      *)
(*CALLS: (LIST OF FUNCTIONS)                          *)
(*                                    *)
(*PARAMETERS: NAME AND ROLE IN ALGORITHM OF EACH *)
(*                                              *)
(*AUTHOR: name of author                      *)
(*REVISIONS: DATE, REASON                          *)
(*             AUTHOR FOR EACH (if different) *)
(*VERSION: x.xx                                       *)
(******************************************************)

Each of these documents must be placed in ONE binder or folder. Each separate document must be
clearly labeled and separated from the others. The diskette containing the code must be inside and
securely fastened. ALL WRITTEN MATERIAL MUST BE EASILY READABLE AND THE PAGES SHOULD
BE EASY TO TURN IN THE BINDER. ILLEGIBLE WORK WILL NOT BE GRADED AND YOU WILL
RECEIVE A "ZERO" FOR ANY SUCH PRODUCT SO REJECTED. Failure to conform with these standards
will result in an immediate loss of points.

The following scale will be used for grading:
                        PERCENTAGE       PERCENTAGE

PRODUCT         OF PROJECT          OF FINAL
                  GRADE                        GRADE    

    Structure Charts: 20                 5.00
    Integration Plan:   10                  2.50
     Code/Execution: 60               15 .00
         User's Manual:                                                 10                            2.5        0
  Total:           100%                25.00%

    Due Date schedule   :
There will be NO extensions or late submissions for this project! Any project or
portion thereof    NOT    submitted on time will be rejected!

              PRODUCT                          DATE    
Structure Chart:         11 - 20 - 96 (Initial Version)
Structure Chart:         12 - 09 - 96 (Final Version)
Integration Plan:         12 - 09 - 96
Code/Execution: ALL code is due by 5pm on 12- 9 - 96.  • DOC Day  •
User Document:   12 - 09 - 96

The following deliverables are due on December 9th:
a. Hardcopy and softcopy LISTING for all code.
b. A diskette, (system labeled: Win 3.1, 95 or NT), with all source code and a single
executable image in the root directory, NOT a  subdirectory. The executable image must run by
typing doc . The files on the disk may be zip compressed in self extracting archives and f i le
protection should be set to allow anyone access. Do NOT submit any 51 /4 " MSDOS disks. Only
31/2 inch DOS (FAT)1.4 MB disks are to be submitted. No "extra" files (other than the . r fs ,
.gor, .dr, .txt files and user manual files) should be on your diskette.
c. A hardcopy and softcopy of the user's manual. The softcopies (2) should be in the word
processor format used to create the manual and also in standard ASCII text format.
d. Modified final up-to-date Structure Chart + the original initial version.


